Installing SOX Check Approval Web Screens

This guide provides instructions for installing SOX Check Approval Web Screens for SOX Check
Approval 2018-2023.

e If you are upgrading SOX Check Approval from a previous version, see “Updating to
SOX Check Approval - 2018-2023".

o Note that you must install the Desktop program for SOX Check Approval before you
install the web screens for SOX Check Approval.
Note the following points:

e Do notinstall SOX Check Approval Web Screens unless you use Sage Web Screens.

Web screens are launched from Sage 300cloud running in a web browser. You cannot use
SOX Check Approval Web Screens unless you are running Sage 300 in a web browser.

e Web screens are version-specific.

This package provides web screens for Sage 300 version 2021, 2022, and 2023. You must
install web screens that match your version of Sage 300.

e Web screens only provide the Uls for running programs in an internet browser. You must
install the Desktop version of SOX Check Approval in order to run the program.

Installation Files for SOX Check Approval Web Screens

The SOX Check Approval Web Screens “Download” zip file contains 6 installation files that
support 3 different versions of Sage 300.

You must use the installation files that match your version of Sage 300.

e Sage 300 version 2023 0 for the original release of Sage 300 2023

o TCSAWeb 2023 0 setup.msi -- installs Web Screens

o TaiRox.SCA.Customization_2023 0.zip -- installs A/P Batch List button
e Sage 300 version 2022_2 for Sage 300 2022.2 and higher (e.g. PU2, PU3)

o TCSAWeb 2022 2 setup.msi -- installs Web Screens

o TaiRox.SCA.Customization_2022_ 2.zip -- installs A/P Batch List button
e Sage 300 version 2021_2 for Sage 300 2021.2 and higher (e.g. PU5, PU6)

o TCSAWeb_ 2021 2 setup.msi -- installs Web Screens

o TaiRox.SCA.Customization_2021 2.zip -- installs A/P Batch List button

You import the Payment Batch List customization using the Sage 300 Web Admin Configuration
application.

Note regarding the Web version of SOX Check Approval

Web screen installation files are Sage 300-version-specific. You must install a web
version that matches your version of Sage 300. This package includes installation and
customizations files for Sage 300 version 2021 (PU2 and higher), 2022 (PU2 and higher),
and 2023.
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Steps for Installing Web Screens

Before you install:

e If you previously installed the Web Screens, uninstall “TaiRox SOX Check Approval Web
Screens” from all computers running Sage 300 applications.

o Run ‘iisreset” after uninstalling prior versions of SOX Check Approval Web Screens, and
clear your browser’s cache of temporary Internet files.

¢ Install the new Check Approval software on all computers running Sage 300 applications
using the following installation file.

Desktop-2018-2023.msi

Run RegAcc.exe on each workstation that runs Sage 300 from a server (or run
Workstation Setup with “repair”).

o Activate the new version of SOX Check Approval if you are updating from a version prior
to SOX Check Approval 2018-2021 (January 2021).

To install SOX Check Approval Web screens:

1.

Install the new Check Approval Console Web Screens where the Sage 300 Web Screens
are installed, using one of the following installation files.
TSCAWeb 2023 0 setup.msi— for Sage 300 — original release
TSCAWeb_2022_ 2 setup.msi — for Sage 300 version 2022 with PU2 or higher
TSCAWeb_ 2021 2 setup.msi— for Sage 300 version 2021 with PU2 or higher
Delete any existing customizations for the A/P Payment Batch List Web Screen from prior
versions of SOX Check Approval.
» Login to the Sage 300 Web Screen Admin Configuration application.
<web server>/Sage 300/Admin
= Delete any prior version of the A/P Payment Batch List Web Screen customization.
(Select it from the Package ID dropdown and click the Delete button.)

Import the new customization package for A/P. See Installing Sage 300 Web Screen
Customizations for details on importing — and deleting — customization packages.

Using one of the following customization files:

TaiRox.SCA.Customization_2023_0.zip — for Sage 300 — original release
TaiRox.SCA.Customization_2022 2.zip — for Sage 300 version 2022 with PU2 or higher
TaiRox.SCA.Customization_2021 2.zip - for Sage 300 version 2021 with PU2 or higher

= Login to the Sage 300 Web Screen Admin Configuration application.
<web server>/Sage 300/Admin

= Use the Browse button to find TaiRox.SCA.Customization_202n_n.zip.

= Use the Import button to import it.

= Use the Assign button to assign it to the Sage 300 company database.

Run “iisreset” after installing the SOX Check Approval Web Screen customizations and
clear your browser’s cache of temporary Internet files.

See Clearing Your Browser Cache After Installing Customizations.
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Installing Sage 300 Web Screen Customizations

Follow these instructions to install the Web Screen customization package for SOX Check
Approval. The customization package adds a button to the A/P Batch Payment list for submitting
payment batches for approval and for checking the approval status of submitted batches.

To install Web Screen customization packages for Sage 300cloud:

¢ Install the latest version of SOX Check Approval and SOX Check Approval Web
Screens.

e Copy the customization zip file for SOX Check Approval Web Screens (for example,
TaiRox.SCA.Customization_202n_n.zip) to a convenient location. You will need to find it

easily to import it.

e Open your browser and browse to <Sageserver\instance>/Sage300/admin to open the
Sage 300 admin portal.

S Sage300 x

< C @ @] localhost/Sage300/admin

sage
300

Sign In to Sage 300 ‘

(Admin Configuration)

‘ SAMSYS

1o eneal “

e Select the System database, and sign in with an Admin password.

On the Import Customizations screen:

¢ Click the Browse button and find the Customization zip file
(TaiRox.SCA.Customization_202n_n.zip).

300 )

Import | Manage

Import Customization Packages

Package ID * Package Description

| All ‘ - | All imported packages

« © 4 B> ThisPC > Deskiop » v o £ Search Deskiop

Organize v New folder

[ Dacuments A Name Da dified Type Size

& Downloads OpenOffice 4.1.7 (en-US) Installation Files
Sage 300 2020 PU3

| TeiRox

| TeiRox SCA. Customization.zip

I Favorites
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¢ Double-click the zip file to select it, and click Import button.)

Import Customization Packages

Package ID * Package Description

| 0580ect12-6219-46ba-be73-Ic3eea1f23eb ‘ = |

Browse

Custom screens for SOX Check Approval

Installing Sage 300 Web Screen Customizations

e Click the Assign button at the bottom of the Import screen, select the companies that use

SOX Check Approval, and click OK.

o -
Deploy Customization
PaymentBatchList PaymentBa TaiRax
| | Company Description
SAMINC Sample Company Inc.

SAMLTD

- " \

Sample Company Ltd.

v;gelzl of1

e Sign out of Sage 300 and exit the browser.

e Open a Command prompt and enter iisreset to restart iis.
=ANE X

BE¥ Administrator: Command Prompt

Microsoft Windows [Uersion 6.1.76811

Copyright {c> 2082 Microsoft Corporation. All rights reserved.

m| s

C:\Users user>iisreset

fttempting stop...

Tnternet services successfully stopped
nttempt
Interne

eruices successfully restarted

C:\Users user>

10

1-1oflitems

o Verify the installation by signing in to the Sage 300 portal and opening the AP Payment

Batch List program.

21 Administrator +

»
»

Accounts Raceivable .
AJ/P Payment Batch List
‘Administrative Services
Baich Number
Bank Services 61«1 | [Q] [ ShowPosted and Deleted Batcnes
Common Services
IIl £t Columns

General Ladger

Batch Number Baich Date Number of Eniries. “Total Amount

Inventory Contral | 61 1232020 new batch 1 252,201,580

Muliple Contacts

Canadian Payroll Employee
Timecards

US Payrol Employee
Timecards

W # & B @ ok IFPB DS

SOX Check Approval

SOX Check Approval for Sage 300
Copyright © 2009-2022 TaiRox Software, Inc. All rights reserved.

Ready To Post

Sample Company Lid Q e 7
Sewh  Hep  Setres



Installing SOX Check Approval Web Screens Installing Sage 300 Web Screen Customizations

Clearing Your Browser Cache After Installing Customizations

Note that all users should clear their browser caches when
you update to a new version of Sage 300 or TaiRox Web screens.

Follow these instructions to clear the cache on different browsers:
Microsoft Edge

€83 Settings

<« G @ @ Edge | edgey/settings/privacy

Settings Tracking prevention @

Websites use trackers to collect info about your browsing. Websites may use this info to improve sites and show you ¢ E2 New

ate window  Ctrl+Shift=N

Q. Search settings personalized ads. Some trackers collect and send your info to sites you haven't visited.

Zoom - 100% +
Brofies Tracking prevention
= Faverites Ctrl+Shift=0
|| 1 Privacy, search, and services 1
. . D Histor Chrish
Q) Appearance o Basic O Strict D wirey
g L Downloads Ctrl+)
O Onstartup « Allows most trackers across all sites + Blocks 2 majority of trackers
sites B A >
(5 New tab page il likely be
* Content and ads will likely be less * Contentand ads 2 {:g Ext
[ Share, copy, and paste - Site: i as expected personalized
c might not work Collections Ctrl+Shift=Y
@ Cookies and site permissions harmful tracks
n + Blocks known harmiul tracke
[@ Default browser S Print Cirl+P
| Downloads 6 Web capture Ctl+Shift=5
2 Family safety ‘ve blocked from tracking you & sha
Al Languages Exceptions &) Find on page Ctrl+F
© Frinters Allow alltrackers on sites you choose: .
O System Always use “Strict” tracking prevention when browsing InPrivate More tools >
) Reset settings I €3 settings I

[ Phone and other devices Clear browsing data (@ Help and feedback >

@ About Microsoft Edge This includes history, passwards, cookies, and mare. Only data from this profile will be deleted. Manage your data Close Micosoft Edge

Clear browsing data now Choose what to clear

Choose what to clear every time you close the browser >

Click the Settings and More button in the upper-right corner to display the menu.
Select Settings from the Menu.

Select Privacy, Search, and Services from the Settings Menu.

Scroll down to Clear Browsing Data.

Click the Choose What To Clear button.

Select a Time Range of All Time.

N o o b~ owbdR

Check Cached Images and Files. You can uncheck the other data if you want to keep
it.

8. Click the “Clear Now” button.
9. Close ALL Edge browser windows

10. Restart Edge and sign on to Sage 300 again.
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Internet Explorer

Installing Sage 300 Web Screen Customizations

-

)

() Start with tabs from the last session
@ Start with home page
Tabs

Change how webpages are displayed in tabs.

Browsing history

Delete temporary files, history, cackies, saved passwords, and web
form informatan.

[ Delete browsing history on exit

Appearance

3

Colors | [ Languages | [ Fonts | [ Accessivity |

[ ox [ conca |[ spy | knew sooner

Select “Internet Options” from the menu.

P 0D PR

o Preserve Favorites Website data

N
| < Intemet Options (9 [ - @ serch. o~ & %
r? Print ’
E ] senera [F=curity | privacy | content | connections | Programs | Advanced | m
File v
Home page Zoom (75%) v
To create hy tab: ch add ts own ine.
l/" 0 creats home page tabs, type each address on its own line. Safety ,
http://www tairox.com/ A
Add site to Start menu
View downloads Ctrl+)
[ usecurent | [ usedefault | [ usenewtsb Manage add-ons
Startup F12 Developer Teols

f
Facebook
orts  Entertainment  Lifestyle Heal
/—-

Home hacks that
everyone wishes they

Go to pinned sites

Compatibility View settings

Report website problems
Internet options

Thout Internet Explorer

T

Ridiculously funny home
renovation fails

Go to the Tools menu (click button in the upper-right corner to display the menu).

Under the General tab, Browsing History section, click on the Delete button
Check/select only the following items on the list:

o Temporary Internet Files and Website files

Uncheck/deselect the rest of the items on the list, especially the Passwords item.

Click Delete.

Wait for the message Internet Explorer has finished deleting the selected browsing

history to appear at the bottom of the page.
8. Click Apply.
9. Click OK.

10. Close ALL Internet Explorer browser windows.

11. Restart Internet Explorer and sign on to Sage 300 again.

Google Chrome

8 Settings

<« C @& Chrome | chrome://settings/privacy

Settings Q_  Search seitings

2 Youand Google

Privacy and security

B  Aubofil

Clear browsing data

B Clear history, cookies, cache, and more

@  safetycheck

@  Privacy and security
@

Cookies and other site data

Third-party cookies are blocked in Incognito mode
@  Appearance

Q,  searchengine

@ oy
Safe Browsing (protection from dangerous sites) and other security settings

CrleT
Ctrl+N
nito window  Ctrl+Shift+N

History >
Downloads
Bookmarks »

Zoom - 100% =+

Print... Ctrl+P
» Cast..
Find...
Wore tools >

Ctrl+F

Edit Cut Copy Paste

BN Default browser
_, SiteSettings

() Onstartup
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Click the Settings button (in the upper-right corner of the browser window).
Select Settings.

Select Privacy and Security on the Settings menu.

Click Clear browsing data.

Select All Time on the dropdown menu.

o a0k~ wDbd R

Check/select the following item on the list:

o Cached images and files

7. Uncheck/deselect the rest of the items on the list, especially the Passwords item.
8. Click the Clear data button.

9. Close ALL Google Chrome browser windows

10. Restart Google Chrome and sign on to Sage 300 again.

Mozilla Firefox

© 3¢ Options X
PR RIS O Freior sboutpreferenceskprivacy % n @ ® E
S Sage 300 @ Sign in to Firefox >
o L Protections Dashboard
’ Find in Options
B New Window Ctrl+N
q . ©3 New Private Window Ctrls Shift-P
'ﬁ' General Cookies and Site Data
B Restore Previous Session
0 Your stored cookies, site data, and cache are currently using 151 MB of disk Clear Data...
Home -
space. Learn more Zoom we + o2
Manage Data...
— Edit *
Q Search ' B @
Delete cookies and site data when Firefox is closed
« Manage Exceptions... I\ Librery N
a Privacy & Security =0 Logins and Passwords
e Add-ons Chrl+Shift+ A
K7 Sync Logins and Passwords 2% Options
Ask to save logins and passwords for websites Exceptions... 7 Customize...
i Open File. Ctrl+0
Autofill logins and passwords Saved Logins... P
Save Page As.. Ctrl+S
Suggest and generate strong passwords
& Print.
Show alerts about passwords for breached websites Learn more
Q_ Find in This Page... CtrieF
Use a Primary Password Learn more ge Primary Password More >
Formerly known as Master Password \Web Developer >
T What'sNew >
@ Help >
O Bt Cirl+Shift~Q
History
Firefox will  Remember history -
& Extensions & Themes 3 . 3
Firefox will remember your browsing, download, form, and search history. Clear History...
@  Firefox Support
aa o

Click on the menu button (three bars in the upper-right corner of the browser window).
Select Options.

Select Privacy and Security from the Options menu.

Scroll down to the History section and click the Clear History button.

For “Time Range to Clear”, select Everything.

o o bk wDdPRE

Check/select only the following item on the list

o Cache

Uncheck/deselect the rest of the items on the list, especially the Active Logins item.
Click the OK button.
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9. Close ALL Mozilla Firefox browser windows

10. Restart Mozilla Firefox and sign on to Sage 300 again.

Apple Safari

iew History Bookmarks Window Help

Ctrl+Z Applelnc. & & Q- Google | O %~
CirleShifteZ  ITbe  Wikipedia  Mews (38) *  Popular v

Cut Ctrl+X ~
Copy Ctrl+C

Paste Ctrl+V e ep

Delete Del

Select All CirleA nline and get Specialist help, free no-contact delivery, and more.

AutoFill Form Ctrl+Shift+A

Find 3

Spelling and Grammar

iPhone 12

Reset Safari.,

iy i Ctrle Alt+E Blast past fast.
| eI inE s EGeE e From $29.12/mo. or $699 before trade-in.!
Preferences... Ctrl+,

uy directly from Apple with special carrier offers.

Select Edit on the menu bar.
Select Empty Cache.

Click Empty.

Are you sure you want to empty the cache?

Safari saves the contents of webpages you open, and stores them in

ﬁ a cache, s0 the pages load faster when you visit them again.

® Concel

4. Close ALL Apple Safari browser windows
5. Restart Apple Safari and sign on to Sage 300 again.
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